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PRODUCT RIGHTS and LICENSE
Warranty Information
Hexit is offered "as is" and without any warranty either expressed or implied, including
without limitation as to merchantability or fitness for a particular purpose and/or noninfringement. The author will not be liable for data loss, damages, and loss of profits or
any other kind of loss while using or misusing this software. This warranty information
must be acknowledged before the calculator will operate.
Evaluation and Registration
Hexit is a freeware product. No registration is required.

Distribution
Hexit can be distributed freely.
This program is produced by a member of the Association of Shareware Professionals
(ASP). ASP wants to make sure that the shareware principle works for you. If you are
unable to resolve a shareware-related problem with an ASP member by contacting the
member directly, ASP may be able to help. The ASP Ombudsman can help you resolve
a dispute or technical problem with an ASP member, but does not provide technical
support for members' products. Please contact the ASP Ombudsman online at
http://www.asp-shareware.com/omb.
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1 Overview
Hexit supports standard C programming language data types. The default setting is
unsigned long. The data types include the following.
· character and unsigned character (char and unsigned char)
· integer and unsigned integer (int and unsigned int)
· long integer and unsigned long integer (long and unsigned long)
· float and double (converter only)
Hexit includes four displays including
· hexadecimal (hex) calculator display
· hex format display
· decimal format display
· binary format display
Figure 1-1 shows the Hex Calculator. The Hex Calculator button grouping includes
hexadecimal numeric buttons, basic arithmetic and logical operators. The Hex
Converter grouping includes two edit displays, HEX and DECIMAL, which accept
keyboard inputs to perform conversions. The third display, BINARY is used to show the
binary equivalent of the current hexadecimal or decimal number. Data types can be
selected using the Data Type menu item.

Figure 1-1 Hexit Features
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The Hex Calculator supports the following arithmetic and logical operators.
·
·
·
·
·
·
·
·
·
·
·
·
·
·

CLR
/
*
+
=
%
~
^
&
|
>>
<<
Mot

clears displays and resets calculator
division operator
multiplication operator
subtraction operator
addition operator
equal operator
modulus operator (remainder from division)
complement logic operator
bitwise exclusive OR (XOR) logic operator
bitwise AND logic operator
bitwise OR logic operator
shift right logic operator
shift left logic operator
Mot-Int byte order format (Motorola or Big Endian, Intel or Little Endian)

The Hexit has a Help Instructions menu item listed under the Help menu item on the
main menu. Help Instructions opens a help dialog box to describe button functions and
groupings.

1.1 Hex Calculator Operation
1.1.1 Arithmetic and Logic Calculations
Hexit performs simple arithmetic and logic calculations. It does not support order of
precedence so all calculations are performed in the order in which they are input. The
general input sequence is first number -> operation -> second number -> operation …
The three periods (…) at the end of the sequence above indicates that the sequence can
continue indefinitely. For example to add together 12 h + A6h = B8 h use the following
button sequence.

Figure 1-2 shows the Hexit hexadecimal, decimal, and binary results. All four Hexit
displays support the calculator function. Note that the Hex Converter display hex and
binary values are zero justified based on the number of digits required to complete the
data type.
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Figure 1-2 Hexit Addition Operation Result

1.1.2 The Complement Operator
The complement operator (~) does not take a second argument it merely takes the
complement of the argument in the Hex Calculator display. Continuous pressing of this
operator toggles the display between the argument and its complement.

1.1.3 Logic Operators
To perform a logical AND, OR, XOR, modulus, or shift operation use the same process
as for the arithmetic operation shown previously. For example, to find the result of 12 h
XOR A6h = B4h, use the following sequence. Figure 1-4 shows the result of the XOR
operation.
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Figure 1-3 Results of 12 h XOR A6 h
The shift operators, shift right (>>) and shift left (<<) require two arguments; the number
to be shifted and the number of places to shift. For example, to shift a 1h four places to
the left which equals 10h or 16 d, use the following button sequence.

Shift Operator Rules:
·
·

The results of a shift operation is undefined if the second argument is greater
than or equal to the number of bits of the first argument.
The value of a shift right expression 1st argument >> 2nd argument is
1st argument / 2

·

The value of a left shift expression 1st argument << 2 nd argument is
1st argument × 2

·

2nd argument

2nd argument

Bits vacated by the shift operation are zero-filled for unsigned arguments.
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·

For signed arguments, the sign bit is propagated into the vacated bit positions.
The shift is a logical shift if the 1st argument is an unsigned data type. Signed
data types result in an arithmetic shift.

1.2 Hex Converter Operation
The Hex Converter takes inputs from the keyboard whenever a conversion is desired.
The HEX, DECIMAL, and BINARY displays support the calculator functions when the
calculator is being used. To perform a conversion, an argument must be input into either
the HEX display or the DECIMAL display, depending on the number base conversion
desired. The BINARY display does not accept inputs and is a read-only display.
To input a number into either the HEX or the DECIMAL displays there must be a cursor
active in the display. This can be accomplished by clicking on the desired display with
the mouse cursor or by tabbing through the Hexit buttons using the tab key on the
keyboard. Once the display has a cursor blinking in it, i.e., it is the active display, the
desired number can be typed in for conversion. Hexit converts and updates the displays
as each digit is input (case does not matter for hexadecimal digits between A and F).
Decimal points are ignored unless the float or double data type is selected and the
DECIMAL display is the active display receiving input.

1.2.1 Converting a Decimal Number
To convert a decimal number to both hexadecimal and binary, type the number into the
DECIMAL display. For example to convert 126d to hexadecimal and binary format, type
the following into the DECIMAL display as shown in Figure 6-4. The HEX and BINARY
displays are updated with each digit input.

A. 1 digit input of 126d

B. 2nd digit is input of 126 d
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C. 3rd digit is input of 126 d
Figure 1-4 Conversion of 126 d

1.2.2 Converting a Floating Point Number
To convert a floating point number the data type must be set to either float or double.
Select either float or double in the Data Types grouping. Then input the number into the
DECIMAL display. The byte order for the floating point number will depend on the
setting of the Mot button. This is because Hexit reads the floating point format of the
number out of the computer’s memory. Figure 6-5 shows this operation with the button
set in Mot mode (Motorola or Big Endian byte order). Figure 6-6 shows the same
operation when Mot is toggled to Int mode (Intel or Little Endian order).

Figure 1-5 Double Format Conversion in Mot Mode

Figure 6-6 Double Format Conversion in Int Mode
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1.2.3 Converting a Hexadecimal Number
There are two ways to convert a Hexadecimal number to decimal and binary format.
The first way is to input the number into the Hexit HEX Calculator. The HEX Converter
automatically converts all numbers shown in the Hexit HEX Calculator Display. The
second way is to type a hexadecimal number into the Hexit HEX Converter’s display.

1.3 Hexit and Negative Numbers
The following two rules apply to dealing with negative numbers when using Hexit.
·
·

Hexit Hex Calculator performs bitwise operations the same for signed integers
and unsigned integers.
Signed integers are always input in hexadecimal format (two’s-complement
form). Note there is no change sign button on the HEX Calculator. To input a
negative number the number must be input in its hexadecimal format. Use the
HEX Converter to get the hexadecimal format for a negative decimal number.
Remember to set the data type to a signed type (char, int, or long) when
calculating with negative numbers.

2 Menu Items
Figure 2-1 shows the Hexit main menu which includes settings for Data Type, View, and
Help.

Figure 2-1 Hexit Menu Items

2.1 Data Type
Figure 2-2 shows the settings for Data Type. Highlighted is the Integral Types; unsigned
character (unsigned char), character (char), unsigned short integer (unsigned short),
signed short integer (short), unsigned long integer (unsigned long), and long integer
(long).

Figure 2-2 Data Type and Integral Data Types
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Figure 2-3 shows the settings for Real Types of which there are two; float and double.
The real data types are only supported by the Hex Converter section of Hexit. Attempts
to use these types with the Hex Calculator section will result in an error message.

Figure 2-3 Real Types

2.2 View
Figure 2-4 shows the View Menu Items. There are four selections; Status Bar, Remove
Border, Make Topmost Window, and Use Programmer Symbols.

Figure 2-4 View Menu Item

2.2.1 Status Bar
The Status Bar menu item is a toggle that enables or removes the status bar at the
bottom of the Hexit window. It is recommended that this setting be set or enabled so
that status messages can be read.

2.2.2 Remove Border
The Remove Border menu item is a toggle that enables or removes the window border.
This is a user preference only; however, removing the window border requires that the
File menu item be used to exit the program.

2.2.3 Make Topmost Window
Make Topmost Window is a toggle setting. When it is set, Hexit will always be the
topmost window on the desktop. This is handy when you need to perform calculations
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while working with another program and you want the calculator to stay on top of the
other application.

2.2.4 Use Programmer Symbols
Use Programmer Symbols is a toggle setting. When it is set, Hexit will use C-style
symbols for logic functions. Examples include % for modulus operator and ^ for the
exclusive OR operator. When this setting is disabled Hexit will use name-symbols for
logic functions. Examples include mod for modulus operator and xor for the exclusive
OR operator.

2.3 Help
The Help menu item includes three selections; About Hexit, Help Instructions, and
Register Hexit. About Hexit gives the version number and copyright notice. Help
Instructions calls a help dialog panel that gives a brief description of the Hexit buttons.
The Help Instructions panel is shown in Figure 2-5. Register Hexit calls a message
panel with information to register Hexit. Although registration is not required, users can
register via e-mail to insure that they are notified of future version changes.

Figure 2-5 Help Instructions

3 Error Messages
Hexit has only one error message to alert the user when an input error occurs. Figure
3-1 shows the error message. This message is displayed whenever a hex calculation is
attempted on a real data type.
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Figure 3-1 Error Message

4 Product Test Information
Hexit has been tested using a variety of test calculations. These test calculations are
designed to verify that Hexit performs calculations correctly. It is impossible to build a
list of test calculation to address every possible combination of functions and calculating
conditions that can be encountered and so it is always possible that a calculation error
may go undetected in testing. Please submit any calculation errors or problems
encountered to WFW Software by sending an email to info@wfwsoftware.com. WFW
Software wants to provide the best calculator possible and is interested in suggestions.
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